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Preface

Thank you for purchasing an Autonics product.

This user manual contains information about the product and its proper use, and should be kept
in a place where it will be easy to access.
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User Manual Guide

This user manual contains information about the product and its proper use, and should be kept
in a place where it will be easy to access.

= Please familiarize yourself with the information in this manual before using the
product.

®=  This manual provides detailed information on the product's features. It does not offer
any guarantee concerning matters beyond the scope of this manual.

"  This manual may not be edited or reproduced in either part or whole without
permission.

=  Auser manual is not provided as part of the product package.
Visit www.autonics.com to download a copy.

=  The manual's content may vary depending on changes to the product's software and
other unforeseen developments within Autonics, and is subject to change without
prior notice.

®"  This manual is produced based on DAQMaster 2.6.0 version.

I Vi © Copyright Reserved Autonics Co., Ltd.
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User Manual Symbols

Symbol Description

% Note Supplementary information for a particular feature.

. Failure to follow instructions can result in serious injury or death.
A Warning Iury

. Failure to follow instructions can lead to a minor injury or product damage.
& Caution jury orp 9

Ex. An example of the concerned feature's use.

X1 Annotation mark.

© Copyright Reserved Autonics Co., Ltd. Vi I
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Avutonics 1 DAQMaster Overview I

1 DAQMaster Overview

1.1 Overview

DAQMaster is a comprehensive device management program that can be used with Autonics
communication supporting products.

DAQMaster provides GUI control for easy and convenient management of parameters and
multiple device data monitoring.

B8 DAQMaster Free - +

Tool

— | = &

[ Open Open Ssve  SaveAs | Disconnect| Stop log  Viewlog
FromLst  Project

- Project ] 4 F > Property

Delete  View - arid (=@ =] Line Graph Project

Type No. Device TagMName Time ce Grapl as - Z =l General
o E e COM3_t_Present Vahue 20160421 B Project Name
= c e 201604215 | | Company
Runtime Screen = I 1
COM3_1_Heating MV 20160421 5 1 ! User
= = Deseription
2 I | =l Data File
COM3_1_Heater Gurrent 2016042 | | Data Folder
| comz oo ]

£ DAQ Space

Data File Creation Rules
CSV Time Type
= Log Data Schedule
Log Data Schedule sl
Active Schedule il =)
Address = When Opening Project
coM3 Run Mode
& ModBus Master RTU, 3 Layout

& . s ALTONICS
1

TK 4V B4CR

Del  Change

Tag Name
«

Delete Al Select Al Delete the selected item(s)
Ho. Device Address  Source Tag Name Type R/W ReadMode Unit Calculation Description
o COM3TK4 1 MAN Lamp COM3_1_MAN Lamp Digts. R Cont
o COM3.TK4 1 DI COM3_1 DI N Digts. R Cont

Group
Analog
Digital
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1.2

Features

(1) DAQMaster Pro Version Feature

(2)

Data Base

Database managing system (Access, MySQL, SQL Server, Oracle, SQLite) turns
information into database in real-time, making creation and management of database
easier.

Real-time Logging

At the set cycle and condition, real-time log file is generated in CSV file.

Modbus Device Editor

You can add the any modbus devices which are not supported at DAQMaster to set
and monitor the property and 1/0.

OPC Client

Itis Interface method for better compatibility among application programs based on
OLE/COM and DCOM technology of Microsoft. It provides industry standard
mechanism for communication and data conversion between client and server.
DDE Client

It supports communication (IPC) among process embedded in Microsoft Window
system, allowing application programs to share and exchange information. This
function uses shared memory and provides a common protocol (instruction set and

message format) to application programs.

Featurs

Multiple Device Support

Simultaneously monitor multiple devices and set parameters. Simultaneously connect
units with different addresses in a single device. Multiple RS-232 ports are available for
communications using Modbus remote terminal unit.

Device Scan

In cases of multiple units (with different addresses) connected together, the unit scan
function automatically searches for units.

Convenient User Interface

Freely arrange windows for data monitoring, properties, and projects. Saving a project
also saves the screen layout.

Project Management

Saving data as a project file includes added device information, data monitoring screen
layouts, and I/O source selection. When you open the project file, the last state of the
saving moment will be loaded. Organizing project list makes managing project files
easier.

Data Analysis

| 7
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Performs grid and graph analyses of data files (*.ddf ) using data analysis feature of
DAQMaster. Saves grid data in .rtf, .txt, .html, or .csv files in Data Grid.

e Monitoring Data Log
When monitoring, data log files can be saved in either DAQMaster data files (.ddf) or
CSV (.csv) files. Open files saved in .csv format directly from Microsoft Excel. Define
log data file naming/saving rules and destination folders to make file management
convenient.

e Tag Calculation Editing
Read tag value is available to calculate the set formula for the desired value.

*  Print Modbus Map Table Report
Print address map reports of registered Modbus devices. Modbus map table reports
can be saved in html (*.html) and pdf (*.pdf) formats.

e Multilingual Support
Supports Korean, English, Japanese, and Simplified Chinese. To add a different
language, modify the files in the Lang folder rename, and save.

e Script Support
Uses the Lua Script language and deals with different I/O processes for individual

devices.

© Copyright Reserved Autonics Co., Ltd. 15 I
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1.3

DAQMaster Funtion Comparison Table by Version

Functions General version Pro version
Modifying parameter o) o
Data monitoring o) o)
Data log o) o)
Tag calculation editing 0 o)
Trigger X o)
Data analysis o) o)
Analysis spread X o
User Modbus Device Editor X o
Script Ecitor X o
Database Device X @)
DDE Server X @)
TCP/IP Server X @)
DDE Client X @)
OPC Client X o
WMI Manager X o)
Realtime Log (CSV) o o)
Realtime Log (DB) X o}
SQL Server X o)
Oracle X o
MySQL X o)
PostgreSQL X e}
SQLite X o}
Nexus DB X o)
Inter Base X o
Firebird X o
ODBC X o
MS Access X o
Sybase ASE X o
Sybase ADS X o
DB2 X o
DBF X @)

| EB
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2 Installing the Program
2.1 System Requirements
Iltem Minimum specifications
System IBM PC compatible computer with Intel Pentium II or above

Operations Windows 98/NT/XP/Vista/7/8/10

Memory 256 MB+

Hard disk 1GB+ of available hard disk space

VGA Resolution: 1024x768 or higher

Others RS232C serial port (9-pin), USB port
2.2 Preparations

1st Download DAQMaster program at Autonics’ web page(www.autonics.com).
2nd Close all programs before you start DAQMaster installation.

Double-click DAQMaster setup.exe to start installation.

3rd Installer Language window appears. Select the language and click OK button.

DAQMaster supports English, Japanese, Korean and Simplified Chinese.

Installer Language

Please select the language of the installer

Installer Language

Flease select the languaae of the installer

EI'||;]|i:'-|'|

Cancel

© Copyright Reserved Autonics Co., Ltd.
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4th Click Next in the installation welcome window.

:'_- DAQMaster Free 2.0.0.2705 Setup

DAQMaster

Welcome to the DAQMaster Free
2.0.0.2705 Setup Wizard

rough the installation of

5th Choose Install Location window appears. Default installation path is C:\Program Files

(x86)\DAQMaster.

:'_- DAQMaster Free 2.0.0.2705 Setup

Choose Install Location

nation F

Ic: Wrrogram Files (x36) Woagmaster NG

Install

© Copyright Reserved Autonics Co., Ltd.



Autonics 2 Installing the Program !

6th Click Install button to choose the default path for installation. Click Browse button to
change the installation path. In the Browse Folder window, select the desired

destination folder and then click OK to start installation.

.. Browse For Folder

Select the folder to install

Cancel

:'_- DAQMaster Free 2.0.0.2705 Setup

Installing

Pleas

Extract: autonics. tkd.dev... 100%

Show details

© Copyright Reserved Autonics Co., Ltd. 19 I
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8th Installation Complete window appears after installation is completed.
If the check box in the Installation Complete window is checked, DAQMaster runs
upon completion of installation. You can now run DAQMaster by double-clicking the

DAQMaster icon on the desktop.

:'_- DAQMaster Free 2.0.0.2705 Setup

Completing the DAQMaster Free
2.0.0.2705 Setup Wizard

DAQMaster 3 ter Fr ninstalled on your

When running the program for the first time, the initial screen displays the following.

B paqMmaster Free
View Tool Help

(E=E Hol =)
47 ]

0 5 & B =

New Cpen Save  SaveAs | Comnect  Run Log View Log

Open
FromList  Project

4 v Froperty

Project

- General
Project Name Noname:
Company

= Runtime Screen User

DAQ Space Desaription

= Data File
Data Folder
Data File Creation Rules
CSV Time Type

= Log Data Schedule

Address St Log Data Schedule Sche

Change View -

Active Schedule oFF
= When Opening Project

Run Mode None

Layout Default

Dalete Al Salect Al Delate the selected item(s) Q

No.  Device Address  Source Tag Name Type R/W ReadMode Unit Calculation Description
4  standard Tag (0)
9 Advanced Tag (0)
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2.2.1 Register License
When installing DAQMaster, it provides pro demo version.

After finishing demo period (30 days), pro functions are inactive. Only general version is
available.

After registering license, pro functions are available: DDE Server, Edit ModBus Device, TCP/IP
Server, Script Editor, Trigger, Realtime Log, Miscellaneous (Database, DDE Client, OPC Client,
WMI Manager) and analysis spread of data analysis.

For purchasing licenses, contact the retailers by referring the web site (www.autonics.com).

(1) Entering license

1st Enter Help > License menu.

Project View Tool m
L | E|

Help Check Update | License About

2nd At License, click ‘Request Serial Number’.

License

@ License (") USB Dongle

Contact Autonics to register or upgrade this product.

System ID
Master
| sFa3l
l DAQMaster Pro? l Reguest Serial Mumber
License Tag Limit Client
1 50 1
Dema Remaining Period 0Day

Serial Number
Register
ﬂ Register Code

Enter user information (last name, family name, company, etc.) and click ‘Save
clipboard’. Based on this information, ask the serial number and register code to the

retailer.

[ Request Seral Numier WEE— 2

User Information

Lastname
Firstname
Company
Phane

Email

System Id

Save dipboard l l Cancel

L 4

3rd Enter the provided serial number and register code.

© Copyright Reserved Autonics Co., Ltd. 21 I
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4th When click ‘Register’, the program will be registered as pro version and be able to

use pro functions continuously.

Note

The registered Pro version displays the registered number of licenses and tag limit.
After registering Pro version, '‘Register’ button turns into ‘Upgrade’ button. When you enter

new serial number, registered number of licenses and tag limit are changed, corresponding
to new serial number.

(2) Connecting USB dongle
Plug the USB dongle for DAQMaster Pro license to your PC and run the DAQMaster Pro.
% Note

The license key is installed automatically. (it may take some time.)
You can check the serial number,(the number of) tag limit, and (the number of) client at USB
Dongle of “Help>License” at Help menu,

License X
@1 K @ USB Dongl

Serial No
2018

Tag Limit Client
100 5

2.2.2 Installation Folder Structure

This section explains the folder structure created when you installed DAQMaster.

After DAQMaster installs completely, folders are created as below. The program and all relevant
documents are stored in these folders.

If you selecte the default installation path during installation, a DAQMaster folder is created
under [C:\Program Files] as a subfolder. If you selecte a new destination folder, DAQMaster
folder is located in that folder.

DAQMaster

data

device

help

Lang

plugin

sample

tools

el

I 22 © Copyright Reserved Autonics Co., Ltd.
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(1) Device folder
Device folder contains the device information files (*.dev), which can be monitored and set
with DAQMaster. When the program is executed, the files in this folder automatically add
related devices to the program.
If devices are added or upgraded after the program is installed, copy the device information
file and put it into this folder. The list of available devices will be updated. However, if a
communication related function is added or modified, it also changes the contents of the
[plug-in] folder. Therefore changes may or may not be applied depending on the level of
upgrade.

(2) Lang folder

The language information files (*.lang) available in this program are contained here. The
program reads all files in the folder and automatically adds them to the program when it runs.
The language information files are written in a text file format, so you can modify and add
text using XML Notepad. Korean, English, Japanese, Simplified Chinese language files are
in this folder by default.

(3) Plug-in folder
This folder contains core library files (*.dll) for ModBus communications as well as runtime
screen files (*.rpu). The [prop] folder under the [plug-in] folder stores library files that have
special functions for each specific device.

2.2.3 Uninstalling the Program

There are procedures to uninstall DAQMaster. Select Start > Program > DAQMaster > Uninstall
or Start > Setting > Control Panel > Add/Remove a Program > DAQMaster.

If you select Remove, a confirmation window will appear. Click Yes to remove DAQMaster from
the computer.

2.3 Start and Exit

2.3.1 Start

Double-click DAQMaster on the desktop or select Start > Program > DAQMaster to start
DAQMaster.

2.3.2 Exit

Click X button on the top right corner of the screen to end the program.

Projects are not saved automatically. Please make sure you save the project before you exit.

This project was changed,
Do vou want to Save this project?

0k | Cancel || Exit ‘

© Copyright Reserved Autonics Co., Ltd. 23 I
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2.4 DAQMaster Screen Layout
| B DAQMaster ProfDemo 20days) - * @ E@

View Tool Help

Version 2.5.0.2813 m

0O 58 & B =

Mew  OpenFromlisbpen Projec Save  Save As

Connect

= Runtime Screen

DAQ Space

Change View -
Address Status

Delete Al Select All

Run log  Viewlog

< » v Property

Delete the selected item(s)

No. Device
B Standard Tag (0)
|- /§ AdvancedTag (0)

Address  Source

Tag Name Type R/W ReadMode Unit  Calculation Trigger

The program screen is divided into sections as shown in the preceding screenshot and each

section is composed of the following items.

NO. | Item Description

1 Menu Displays DAQMaster menus by category. If you select a
menu, submenus appeatr.

2 Project List Displays recent projects or usually used project list to
manage the files.

3 Support Device List Displays a list of devices supported by DAQMaster.

4 1/O List Displays parameter items of devices added to My System.

5 Project Shows the basic information of the current project.

6 My System Shows list and connection status of devices connected to
DAQMaster.

7 DAQ List Shows added parameter items in 1/O List.
Records events.

8 Message It displays communication connection and disconnection,
errors.

9 DAQ WorkSpace Displays added Ul items in RunTime Screen.

10 Property AIonvs checking and modifi(;ation of infprmatipn for items in
Project, My System, DAQ List and setting unit parameters.

11 Run Time Screen Displays screen library for data monitoring.

© Copyright Reserved Autonics Co., Ltd.




Autonics 2 Installing the Program !

2.4.1 Menu
(1) Project

View Tool Help
* * *
0 5 & =

Mew Jpen From Listpen Projec Sawve Save As Connect Run Log View Log

1) File
e New: Creates a new project.
e  Open From List: Opens a project from the project list.
*  Open Project: Opens a saved project.
e Save: Saves the project you are working on.
e Save As: Saves the project as a file name.
2) Run
e Connect/Disconnect: Connects or disconnects the device and communication.
*  Run/Stop: Starts or stops monitoring data in the connected devices.
* Log/Stop logging: Saves or stops logging currently monitored data.
* View Log: Views log data during logging. You can check data between Log running
point and View Log executing point.
(2) View

Project

Tool Help

— = =
@ E = I & -
— — E
Tool »  Language - Tile align Horizontal  Vertical Layout +
Align Align
T e

3) View

e Tool: Set for Property, Support Device List, My System, Project, I/O List, Run Time
Screen, DAQ List, Message of the project.

e Language: Changes the program language.

4) Windows
Aligns multiple runtime screens (Data: Grid, Multi Panel, Panel, Line Graph, Bar
Graph, Color Map Graph, Gauge Graph, Histogram Graph, Device: Alarm History
Grid) diagonally, horizontally, and vertically.

© Copyright Reserved Autonics Co., Ltd. 25 I
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3)

5)

Layout
Executes saving, deleting, loading layout. You can select the saved layout at User
Layout.

Layout -

Default

Runtime

Save Layout...

Delete Layout...

Default: Changes docking screen layout to default layout.

Runtime: Displays only run time screen. Select the hidden docking screen at View
menu.

Save Layout: Saves the current layout and adds it at User Layout.

Delete Layout: Select the saved layout and delete it.
Delete Layout.

oK l [ Cancel l
Tool
Project View Tool Help

© 6 @ % &

Time Display Data Analysis DDE Server  dit ModBus Devic TCR/IP Script Editor

Server

Time Display: Displays monitoring time.

Data Analysis: Runs the data analysis program. Allows analysis of DAQMaster data file
(*.ddf).

DDE Server: Runs DDE Server setting.

Edit ModBus Device: Executes Modbus Editor.

TCP/IP Server: Operates DAQMaster as a TCP/IP Server.
Script Editor: Runs Script Decive Editor

f 2
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(4) Help

Project View Tool m
o
7 L B

Help Check Update  License About

¢ Help: Opens the help file.

*  Check Update: Checks the version of the program via the internet update server and
automatically updates to the latest version.

e License: Registers and checks license.
e About: Checks the DAQMaster version.

© Copyright Reserved Autonics Co., Ltd. 27 I
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2.4.2

Support Device List (Docking Screen)

Support Device List shows list of devices supported by DAQMaster. The Support Device List will

be updated continuously.

Support Device List

|Sea|'ch Device

Hame

= ﬂ AUTONICS (16)

- n ARM Series
—‘ BFC
— ‘ CT Series

— - MP5 Series
— - MPSW

L ! TZ/TZN

=+ ﬂ Miscellaneous (3)

E Database
e —
o
IBBE DDE Client
P

#PC OPC Client

= ﬂ Process Automation (7)

F _ DPU (1-Phase)

— . DS(A)-xT Series
— . DS-RRT Series

Function

Modbus Digital Remote Ij0

Digital Display, Fiber Optic Amplifier

Programmable Counter(Timer)

Intelligent Display Unit

Inteligent Display Unit

Pulse(Rate) Meter(ModBus)

Pulze(Rate) Meter

Pulse(Rate) Meter

Multiple Panel Meter

2-CH USB Temperature Data Logger

Temperature Humidity Controller

General-Purpose Temperature Controller

2-CH Modular Type Temperature Controller

4-CH Modular Type Temperature Controller

LCD Display Temperature Controller

Dual PID Control Temperture Controller

Database

DDE Client

OPC Client

Thyristor Unit

m
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2.4.3 Project

Project saves runtime screen information and 1/0 source. Allows you to work in previously used
environments again. In Property at the right side of the screen, you can change general
information, data file, log data schedule, and project opening option. For more information, refer
to '2.4.9 Property'.

Delete View ~

Type
= E Noname

él- Runtime Screen
é‘- DAQ Space

File

||
Grid Grid
i Multi Panel Multi Panel

2.4.4 110 List (Docking Screen)

I/O List shows parameters entries you can monitor for devices added to My System. 1/O List
appears depending on connected devices.

To monitor units of the connected device, you have to list desired sources from 1/O List to the
DAQ List. Searching function is available.

Added sources are shown in gray.

I/0 List x

| | Q
Device Source Interface
B . TK4 1(0/19) RS-232 - COM3
— Present Value Analog, R
— Set Value Analog, R
— Heating My Analog, R
— Cooling My Analog, R
— Heater Current Monitoring Analog, R
— oC Lamp Digital, R
— oF Lamp Digital, R
—— % Lamp Digital, R
— OUT1Lamp Digital, R
— QUTZ2 Lamp Digital, R
— AT Lamp Digital, R
— SV1lamp Digital, R
— SV2Lamp Digital, R
— SV3Lamp Digital, R
— AL1Llamp Digital, R
— AL2 Lamp Digital, R
—— MAMN Lamp Digital, R
— DI-1IM Digital, R
— DI-2IM Digital, R

@ Note

I/0 source cannot be added to DAQ List when the Status is Run.
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2.4.5

My System

My System displays devices and units added from the device list in a tree structure. You can also
check and configure connection status.

You can add, change or delete devices and units (addresses) in My System.

My System X | My System x

Add Del Change View - Add Del Change View ~
Name Address Status Name Address Status
E RS-232 ComM3 Disconnect = RS-232 COM3 Connected
Ié} ModBus Master RTU, 3 Disconnect é} ModBus Master RTU, 3 Connected

TK 4M B4CR Disconnect

\5- Tk AUTONICS  (1)EA &. Tk AUTONICS (1) EA
L
1 Ly

TK 4MB4CR. Connected

= RS-232: Allows property modification related to RS-232 communications in Property when
devices are disconnected.

=  ModBus Master: Allows property modification related to ModBus Master protocol in Property
when devices are disconnected (mode and the number of re-try are displayed).

= Device (TK4): Allows you to see connected device information.

= Unit (1): Allows read and write of parameters as well as check the reading process while
devices are connected.

Connects a device to multiple communications ports as displayed in following image.

My System x

Add Del Change View -

Hame Address Status
= RS-232 COM3 Disconnect
Ié\‘ ModBus Master RTU, 3 Disconnect

J—J. K4 AUTONICS (1) EA
Ly TK4MBACR  Disconnect

E BF 5-Geries ALUTOMICS (2) EA
1

[

2
= DS-RRT Se... AUTOMICS (2) EA
1

[

Disconnect

Disconnect

Disconnect

Disconnect
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2.4.6 DAQ List

DAQ List is a list of I/O sources that will be communicated.

the number of 1/O sources is displayed by signal type in the left list. When one of signal type is
selected, 1/0O sources in right list is rearranged by signal type.

Type
Al 19

Delete Al Select All

Delete the selected item(s)

No. Device Address  Source Tag Name Type R/W Read Mode Unit  Calculation Description

& Group =%  Standard Tag (19) 1~
Analog 5 o COM3_TK# 1 Present Value COM3_t_Present Value Anlog R Cont . |E‘
Digital 14 of COM3_TK# i Set Value COM3_1_Set Value Analog R Cont b
String 0 o COM3_TK4 1 Heating MV COM3_1_Heating MV Analog R Cont %

Vidiea o o COM3 TK4 1 Cooling MV COM3_1_Cooling MV Andog R Cont %
o COM3TK% 1 Heater CurrentM...  COM3_1 Heater CumentM...  Anglog R cont A

Delete Al Select Al Delete the selected ftem(s) Q I
No. Device Address  Source Tag Hame Type R/W ReadMode Unit calculation Description
=4 standard Tag (1)
«  COM3_TK4 1 Present Value COM3_1_Present Value Analog R Cont

‘§  Advanced Tag (0)

Fl e r

(% Note

Elements of the DAQ List cannot be added to a runtime screen when the Status is Run.

2.4.7 Message

Records events (communication status (start/stop communication, error), log status (start/stop
log), etc.) during running the program.

| | [ w0 e 0o maBEDE
%gll%bug
Dlnfo

" lwarn

 Ec——

[ arm

Level Time Tag Message

DAQ List - 6553

Messages are saved as *.txt file or log file. Log file is reside in ‘Message’ folder in the installation
folder.
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2.4.8

DAQ WorkSpace

Displays added Ul screen (Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph, Color Map
Graph, Gauge Graph, Histogram Graph, Device: Alarm History Grid) in RunTime Screen.

Grid = |[® ][ =] | Gauge Graph [ =@][=] 2 Line Graph

No. Device TagHame

Device  TagName Time hh:mm:ss:msec

COM3_COM3_1_Present .. 09:24:30:618

< in v

ol 1L

: ool 4]
[ cavas e | oioear.. | on| - I
a P VEVE Y . T

3

[a@][=] \ Histegram Graph - COM3_1 _Present Value

mage

To add or delete DAQ WorkSpace or change DAQ WorkSpace name, click “DAQ Space” of DAQ
Space screen.

Add
Dl
Change Mame

Click pull-down icon (%) on the upper right of DAQ WorkSpace to select the activated space.
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O e

The name of the DAQ WorkSpace is changed to ‘Gauge and Color’, and ‘Graph’ space is added.

Graph Settings

Coler Map Graph

- Save Image Graph Settings

Time hh:mm:ss:msec
Device Tag Name Time hh:mm:ss:i

Gauage al

Line Graph

M~ Save Image Graph Settings = Zoom InfOut Mode

5735 155740 155745 155750 155755 1
e(hh:
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2.4.9

Property
The Property window allows item checking and modification of Project, My System and DAQ List.

There are check-only items and modifiable items. Modifiable items are displayed as edit type,
combo box type, run type and mixed edit/combo type.

(1) Edit type

(2

3)

4)

TE4 =>1

- General
Device Mame
Unit Address
Model
DAQ Repeat Interval 1000 msec

:E=-| Frame Interval | 20
User Unit Name

| »

m

T4 |

Version

Enter number or text in the blank. Input range (if applicable) is displayed at the bottom.

Combo box type

:B=| Active Schedule |E -
= When Opening Project [
Run Mode Apply

Click the combo button on the right to see a list of items to select.

Run type
|:;=-| Data File Creation Rules | E]|

Click [...] button on the right to start the relevant function.
Data File Creation Rules

View

noname

Run at Save Dialog

Automatic Sequential Mumbers
Date{mm.dd.hh.nn.ss)
Project Name

Space
Date(yyyy-mm-dd)

Data File DDF Fle [=]

Data Folder

Mixed edit-combo type

- [Stop Bit 2 |
Bit Per Byte 1
Hardware - 5 “
2
Snfhuara

Enter numbet or text in the blank (within the range specified at the bottom) and select a
value from the list. Items out of range can only be selected from the combo box list.
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2.4.9.1

Project Properties

Clicking Project Name (default: Noname) allows you to set and enter General (project name,
company, worker, description), Data file (data folder, data file creation rules, CSV time type, etc.),
Log data schedule (log data schedule, active schedule), and Project opening option (run mode,

Property x

layout).

Project
= General
Project Name MNoname
Company
Description
Delete View -~ = Data File
Type File Data Folder E]
o E T Data File Creation Rules E]
CSV Time Type yyyy-mm-dd hh:nn:ss:zzz E]
é— Runtime Screen =l Log Data Schedule
L DAQ Space Log Data Schedule Schedule Setting : 0/0 E]
Active Schedule OFF E]
=/ When Opening Project
Run Mode MNane E]
Layout Default [E]
(1) General
You can enter project name, company, worker, description for project management.
(2) Data File

You can designate log data automatic saving options: the folder to save, creation rule of

data file, and time type of CSV..

Log data is available to save as *.csv or *.ddf file type.
e Data Folder: Designates the folder to save project data.

B[]

-

OK

=

[£= Program Files (x86)
iaw DAQMaster
] data
£ device
£ document
(2] driver

| £ help

£ lang

£ plugin

2] sample

3

m

Cancel
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e Data File Creation Rules: Designates creation rule of data file.

Data File Creation Rules I g

View

noname ‘

Run at Save Dialog

Automatic Sequential Numbers
Date(mm.dd.hh.nn.ss)
Project Mame

Space
Date(yyyy-mm-dd)

Data File DDF File |~

e CSV Time Type: Sets CSV time type.

v i T ==
. re——

| HoanfSeclf“Eeoﬂﬁ:nn:ss::lz”
Date Type |ym—mn~dd
Time Format |I’h:m:ss=zzz ‘

[7] apply All Project

I

* Realtime log: At the set cycle and condition, logging starts in real-time. It is available to
set each I/O. This function is only for DAQMaster Pro version.

When you click "Data File> Realtime Log]...]" at Project Property window, ‘Realtime
Log’ dialog box appears. Click ‘Add’ button executes ‘Log Editor’.

; T
[ Realtime Log [ESNEERC
i) ) (e [aeenin
Category Information
]
I
Close

In the ‘Log Editor’ dialog box, you can set ‘Save Type’ of the real-time log file.
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- When setting save type as ‘Database’,
Set log name, saving condition, and saving interval.

Saving conditions are following.

Condition Description
Periodic Auto Save
o No condition.
(No Condition) ©
_ | When selected tag value is equal to the set value, logging

Equal =
starts.

Less Than < When selected tag value is less than the set value, logging
starts.

Greater Than > When selected tag value is greater than the set value,
logging starts.

Equal or Less than < Whep selected tag value is equal or less than the set value,
logging starts.

Equal or Greater = | When selected tag value is equal or greater than the set

than = | value, logging starts.

Not Equal I= Whe_n selected tag value is not equal as the set value,
logging starts.

Rising Edge -~ | When selected tag value is rising edge, logging starts.

Falling Edge L | When selected tag value is falling edge, logging starts.

In Information box, set ‘Database Connection Info’ and ‘Table Columns Info’.

‘Table Columns Info’ is actiaved after setting ‘Database Connection Info'.

3 Lo edier (]
Database E

g rame | |

PO | © periodic Auto Save (No Condiion) |~ [ et

0 Hour O Min |1 Sec

Information
Database Connection Info E]
Table Columns Info
Field Type Tag Type Tag Name
l oK ” Cancel l
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1st Click ‘Database Connection Info’ [...] button and ‘Database Settings’ dialog box

appears. Set provider, server, port, user name, password and database.

It can access to various data base and provides 1/O function.

Database Settings

Database Connection Settings

[

e
[=]
-

|
|

WoAQMaster ProW2|[ B

Prev

|

Next || concel |

2nd After entering information, click [Next] and ‘Database Table Settings’ appears.

Select the desired table or add the new table. Click ‘Next’.

prweivcs N ey .. ==

Database Table Settings

TN |

[]

Testl

l_m

J1

DeET

Prev

s
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ot

Database Table Settings
] =
(Add || pel |[Deletea
New Table
SN |
Field Type Field
Field | |
Type | =]
Scale |1 =)
Precision 0 4
| AddFieid | |Delete Field |
l New Table H Cancel ]
e [ o el

3rd At ‘Database Time Field Settings’, select save type and time field.
Databasel accdb (e |

Database Time Field Settings
Save Type

(@) DB Field : Tag (7) DB Field : Tag List

(e B
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4th Check the data base file and click ‘OK’.

Databasel.accdb ]
Database Field Settings
Field Type Tag Type Tag Mame
Test2 String [Time]
|
|
|
|
[ [ Prev ] l OK l [ Cancel l

5th After completing the setting, Log Editor dialog displays the set database connection

information. Table Columns Info [...] button is actiaved.
= i '—T'EEF‘T"

At ‘Table Columns Info’, it is available to check and edit elements: field, type, tag type,

tag name
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- When setting save type as ‘CSV File’,

Set log name, saving condition, saving interval.

Saving conditions are following.

Condition Description
Periodic Auto Save
. No condition.
(No Condition) ©
_ | When selected tag value is equal to the set value, logging
Equal =
starts.
Less Than < When selected tag value is less than the set value, logging
starts.
Greater Than > Whep selected tag value is greater than the set value,
logging starts.
Equal or Less than < Whe_n selected tag value is equal or less than the set value,
logging starts.
Equal or Greater = | When selected tag value is equal or greater than the set
than — | value, logging starts.
i | When selected tag value is not equal as the set value,
Not Equal = .
logging starts.
Rising Edge - | When selected tag value is rising edge, logging starts.
Falling Edge L | When selected tag value is falling edge, logging starts.

In Information box, set ‘File Path Information’ and ‘Tag List Information’ .

ﬂ Log Editor

Database

Database
covme

Condition @® Periodic Auto Save (No Condition)

:

Hour |O

=] M Logging

Min |1 Sec

Information

Table Columns Info

Field Type

Database Connection Info

Tag Type

Tag Name

=
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1st Click ‘File Path Information’ [...] button and ‘CSV Log Editor’ dialog box appears. Set

file path settings: folder, file name, file name rule

Esv Log Editor - = ! .

File Path Settings

|C:WProgram Files (x86)WDAQMaster | E]
I |

File Mame Rule |[Auhomah'c Sequential Numbers ] + [File Name] + [Space] |

Automatic Sequential Mumbers Automatic Sequential Mumbers
File Name File Name
Space
Space
Date(yyyy-mm-dd)
Time(hh.nn.ss)

[———

2nd Click ‘Tag List Information’ [...] button and ‘CSV Log Editor’ dialog box appears. Set
tag list settings.

[csv Log Editor . X
—— e L O el
Taa List Settings
[ adgd | [ Dpel | [ Deleteal
Device Tag Mame

[—|—

3rd Click ‘Add’ and DAQ Tag List is appears. Add tags.

DAQ Tag List.

No. Device Address Source Tag Name
- B | standard Tag... |
~«f COM3_TK4 i & : Present Value : COM3_1_Present Value R
L COM3_TK4 in | SetValue | COM3_1_Set Value g TR
¢ COM3_TK4 i - Cooling MV | COM3_1_Coolng MV CAnslg R %
b COM3_TK4 5 . %Lamp | COM3_1_% Lamp ‘Dgtal R
L COM3_TK4 i1 | oC Lamp | COM3_1_°C Lamp ' Dotal R
L COM3_TK4 i1 | Heater CurrentM.,.. | COM3_1_Heater CurrentM... - Analog R A
8 . Advanced Ta... : : :
T
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4th If logging need to be started when executing DAQMaster, check ‘Logging’ at Log

Editor dialog box.

When checking ‘Logging’, the file (*.prx) is created at the set file path and logging

starts.

-
E Log Editor

Save Type Qivciclitd

|

@ Periodic Auto Save (Mo Condition)

= B

Information
Database Connection Info [—
Table Columns Info
Field Type Tag Type Tag Name
R———
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(3) Log Data Schedule

Saves log data at the scheduled time automatically.
* Log Data Schedule: Sets log data saving time.

Log Data Schedule - T [
I 1 Add I Save 3 Del
% Starting Time(hh:mm) : 00:00
‘ [ 1 end Time(hnzmm) : 24:00 _ |
OFF
5 Starting Time{hh:mm)
Starting Time(hh:mm) : 00:00
[ 2 end Time(hh:mm) : 24:00 _
OFF 0 0
6 End Time(hh:mm)
| 24— 0 |
7Splite Log{hh:mm})
|
1 0 '
8 pate Repetition i
Sun
Mon
Tue
Wed
Thu |
Fri
Sat
? oK ” Cancel
No | Description
1 Adds log data schedule items.
Displays scheduled log data items.
2 You can delete the scheduled item by checking the left check box and clicking 3.
‘Delete’ button.
3 Saves or deletes the set items.
4 Designates log data name.
The file name of data file creation rule is displayed next to the data hame.
Designates start time.
Designates end time.
Designates split save time.
7 When you set 1 hour 30 minutues, it saves the file for 1 hour 30 min. and creates
another file and saves it.
8 Designates repetition day of week.
9 Checks log data schedule items.

e Active Schedule: Designates whether to activate log data schedule.

(4) When Opening Project
* Run Mode: Sets runing mode when opening the saved project file.

* Layout : Designates the screen layout (default, runtime, current layout) when opening
the project.
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2.4.9.2 My System Properties

(1) RS-232
Click RS-232 in My System to modify Name in RS-232 general properties.

Add Del Change View - R5-232
Name Address Status = General
= R&-232 Disconnect Mame R5-232
= ModBus Master RTU, 3 Disconnect Information E]
é» =) Configuration
. T ALTONIES (DEA Search Port List Auto Search E]
L 1 TK4MB4CR  Disconnect Communication Port COM3=VCPO E]
Baudrate 3600 B
Check Parity Mane E]
Stop Bit 2 E]
Bit Per Byte ] E]
Hardware Mone E]
Software Mone B
DTR Control Dizable E]
RTS Flaw Control Disable E]

You can also modify Search Port List, Communication Port, Baudrate, Check Parity, Stop Bit,
Per Byte, Hardware, Software, DTR Control, and RTS Flow Control in Configuration.

(2) Modbus Master

You can modify Name in ModBus Master general properties by clicking ModBus Master in
My System. You can also modify Mode and Timeout in Configuration.

My System X | Property X

Add Del Change View ~ ModBus Master
Name Address Status = ‘General
= RS-232 COM3 Disconnect MName ModBus Master
= ModBus Master RTU, 3 Disconnect Information E]
\g- TK4 AUTONICS (1) EA . —
Ly TK 4MB4CR.  Disconnect Mode RTU E]
Timeout 2000 msec
Retries 3

(3) Device (TK4)
Click a device (TK4) in My System to see basic device information in the Property window.

Add Del Change View - TK4
Name Address Status = File
= RS-232 COoM3 Disconnect Description Temperature | Process Contro
é ModBus Master RTU, 3 Disconnect Date 2005.06.02
‘5. s = — wen Date Modified 2011.07.11
Creation
L1 TK4MB4CR  Disconnect Revision 1.0
= Version
Wendor ALITONICS
Product T4
Major Revision 1
Mingr Revision 1
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2.4.9.3

(4) Address (1)

Click the device address (1) in My System to see detailed device information.
You can also change Device Name and set DAQ Repeat Interval.

Property x

TKd >> 1
= General
Device Mame K4
Uit Acess 1
Add Del Change View - Model TE 4M B4CR.
DAQ Repeat Interval 1000 msec
LS L= e Frame Interval 20 msec
E RS-232 CoM3 Disconnect User Unit Mame
= ModBus Master RTU, 3 Disconnect Version HW : 200, SW : 520
Parameter 0
E . TK4 AUTONICS (1) EA m—
1 B TK4YB4CR  Disconnect Parameter 2
Parameter 3
Parameter 4
Parameter 5

You can check and modify device parameters by reading parameters while devices are

connected.
DAQ List Properties
(1) General

If you select items that were added from 1/O List for communication, the Property window

displays item information. You can change Tag Name, Decimal Point, Unit, and Scrept

variables in General proporties and edit Tag

Delete the selected item(s)

value formulas in I/0O Data Calculation.

Type Delete Al Select All
Al = No. Device
B Group ==  Standard Tag (19)
Analog 5 o COM3_TK4
Digital b o COM3_TK4
5tring o o COM3_Ti4
veo o o COM3_TK4
 COM3_TK4

Address  Source

Present Value

Set Value

Heating MV

Cooling MV

Heater Current M...

Tag Name

Type

COM3_1_Present Value
COM3_1_Set Value
COM3_1_Heating MV
COM3_1_Cooling MV
COM3_1_Heater Current M...

Anclog
Anclog
Analog
Analog

LR

Analog

R/W Read Mode Unit

Cont.
Cont.
Cont

Calculation

Cont
Cont

Description

e

Property x

COM3_1_Present Value

TK4 => 1 == Present Value
=EER
Device T4
Address 1
Source Present Value
Tag Mame
Unit
Script Variable Tagl
Description
=} If0 Data Calculation
Edit Calculation
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(2) 110 Data Calculation

You can edit tag values at “Property > I/0O Data Calculation > Edit Calculation”. When
reading the tag value via editing calcuation at DAQMaster, you can get the desired data by
applying the calcuation at data. ‘X’ means the output tag value from device. This function

displays the calcuated output value at DAQMaster.

‘ Edit Calculation [ Template |
| e
Read Calculation x=1 L [rest ][ pekete |
nal Point
NotUsed v

Point

Not Used -

5
XEXTHOCO) HGH0) X2 0s0d

Click ‘“Templete’ at the top-right of the dialog to edit and save the usually used calculations.

It is useful to apply read/write calcuation directly.
Edit Calculation J

‘ Edit Calculation

| Resd caataton =1  [—
nal Point

NotUsed =

wiecontm o [ I - ) (oo- ]
Point

==

e

HACTHGCW HEHW) Fx24S0)

Enter the desired formular and click the ‘Save’ and ‘Apply’.
The saved template is applied the ‘Edit Calculation’ dialog box.

Cm o Ja)
o |
Description
converts from *F to "C
Read Calculation Apply
{x-32)*(s/9) Decimal F
Wite Calculation [¥/] Apply

[ oy [ oo ]
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s ==
Read Calaulation Cdadston ok, 667 '
(x-32)%(5/9) nal Point

Wite Coladaton « I I

Point
Not Used -

Example
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(3) Trigger

In “Property > Trigger > Conditions [...] 7, you can set Trigger event executing conditions. When
Tag velue matches the conditions, Triger event is activated as your setting.

'—Tag Trigger Event - COM1_1 M

SN - (] 8 o [ |

Active

Trigger Name
-
Static Time 0 Hour |0 Min |5 Sec

Check Time [EREEEREIHI

l:l AM 9:46:06 *
-
| OK | l Cancel
e Trigger Management
Management Description
Trigger list Displays the saved triggers as list.

Adds a trigger on the trigger list.

Add trigger You can set trigger name, conditions, etc.

Save trigger Saves the added trigger at the trigger list.

Delete trigger Delete the selected trigger on the trigger list.

Delete all triggers on the trigger list.

Bl | B

Delete all triggers

e Trigger conditions

Conditions Description

Periodic Auto

Save 5 | No condition.

(No Condition)

Equal = | When selected tag value is equal to the set value, trigger starts.

Less Than =, | When selected tag value is less than the set value, trigger starts.
Greater Than - | When selected tag value is greater than the set value, trigger starts.
Equal or Less < When selected tag value is equal or less than the set value, trigger
than = starts.

Equal or Greater > When selected tag value is equal or greater than the set value, trigger
than = starts.

Not Equal I= When selected tag value is not equal as the set value, trigger starts.
Rising Edge - | When rising edge signal is input, trigger starts.

Falling Edge T | When falling edge signal is input, trigger starts.

Static Maintain ¢ | When the value is maintained during the set time, trigger starts.

e Check Time

When the set trigger condition is satisfied during the set check time, trigger starts.
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. Event
Condition Description
Log Start When tag value maches the set condition, logging stars.
Log Stop When tag value maches the set condition, logging stops.

When tag value maches the set condition, Telegram message is sent

Send to Telegram to the designated person.

When tag value maches the set condition, alam sound is played. You
Alam sound play can select audio file you want.

(supported audio file format: *.mp3, *.mp2, *.wav, *.0gg)

When the trigger condition is satisfied, the run time list data cell color
Tag Error Message of this tag is changed. Data value is displayed as ‘Tag error’ and it is
displayed same as log file.

When the trigger condition is satisfied, the run time list data cell color
Tag Alarm of this tag is changed. Data value is displayed as the actual data
value.

X1. Telegram setting

Telegram is a nonprofit open source internet messanger, available in diverse operating system
such as Android, 10S, Window, MAC and Linux. It provides users with source code, encouraging
them to develop desired funtions with the messanger.

By the Bot, virtual conversation contact, when tag value maches the set condition, Telegram
message is sent to the designated person. (Internet connection is required.)

By telegram functions, you can share the massage to the other groups and search the
messages. Please refer to the telegram usage. (Android and IOS system have a identical setting
process. This manual explains with Android)

1st Search “Telegram” at the Andriod Play store and download the application.

2nd You have to creat and register a virtual robot called Bot to receive messages from
DAQMaster.
In contats of Telegram, search and select @Botfather at the upper the magnifying

glass icon.

an?h

Q Vv ‘0 Zaaill51% @ 15:12

51% | 15112

Q

Telegram & @botfather X

GLOBAL SEARCH

«( Capka3sMbl Ha 37106y fiHA

@botfather2, 4750 subscribers

@BotFatherl, 104 subscriber
% @ BotFather &

No chats yet...
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3rd Click ‘Start’ at the below button of the display.
Q Vv ‘0 Zauill 51% @ 15:12

7.5\ BotFather
< (ﬂ bot

What can this bot do?

BotFather is the one bot to rule
them all. Use it to create new bot
accounts and manage your
existing bots.

About Telegram bots:
https://core.telegram.org/bots
Bot APl manual:
https://core.telegram.org/bots/api

Contact @BotSupport if you have
questions about the Bot API.

RESTART

4th Enter ‘/newbot’ in the message box to creat your own Bot.
According to the BotFather message, name a Bot name, Bot user name (must end in
‘bot’ or ‘Bot).
Bot user name is for identifying name at the telegram. It must end in ‘bot’ or ‘Bot’. If

the other named the designated name already, it is not used in duplicate.

(E.g. Bot name: Autonics, user name:at_androido_autonicsbot )
0. Za il 49% 1 15:16

BotFather

/newbot 5.3

Alright, a new bot. How are we going
to call it? Please choose a name for
your bot,

Bot name Autonics 55

Good. Now let's choose a username
for your bot. It must end in *bot*.
Like this, for example: TetrisBot or
tetris_bot.

User name at_androido_autonicsbot ;...

Done! Congratulations on your new
bot. You will find it at . me/
at_androido_autonicsbot. You can
now add a description, about
section and profile picture for your
bot, see /help for a list of
commands. By the way, when
you've finished creating your cool
bot, ping our Bot Support if you want
a better username for it. Just make
sure the bot is fully operational

) Q2 $
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5th Then you are provided with address to chat with the created Bot and token to connect
your Bot and DAQMaster.

Click the given address to join chat with the Bot.
Qv ‘0.zl 48% @ 15:17

? bot

< @i_ BotFather :

Like this, for example: TetrisBot or
tetris_bot.

at_androido_autonicsbot 5.5

Done! Congratulations on your new
bot. You will find it at . me/ Address
at_androido_autonicsbot. You can
now add a description, about
section and profile picture for your
bot, see /help for a list of
commands. By the way, when
you've finished creating your cool
bot, ping our Bot Support if you want
a better username for it. Just make
sure the bot is fully operational
before you do this.

Use this token to access the HTTP

APL:
4891 s N :AAFdps s wfhUc
b8aowfi« == Token

For a description of the Bot API, see
this page: https://
core.telegram.org/bots/api
@} Q2
6th Click ‘Start’ at the button of the display.
One or two times of free conversation are necessary prior to receiving message from
your Bot.

If you send the messages, the group may be not searched.
AV T Zanll 46% @ 1518 [l A ¥ 0, =a il 46% @ 15119

< A Autonics . ¢ A Autonics »

bot bot

/start 1545

Test 1545

START 9 v ? &
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7th At DAQMaster, select the I/O to apply trigger and click “Property > Trigger >

Conditions [...] " and ‘Tag Trigger Event’ dialog box appears. Add trigger and enter

condition/value and select Event as ‘Send to Telegram’. Telegram settings are
available.

8th Go back to the DAQMaster, enter the token of 5th step in the token blank in Tag
Trigger Event dialog. Click ‘Search Groups’.

Tag Trigger Event - COM3_1_Present Value
e D
Active
+ rongae 5
»
[EXTSEN 27 9:46:06 =
L] 2 9:46:06 o
T c-r o Telegram v
Telegram Setting
Tok,Iﬁg BV3U L
[select Al I Search Groups
To: (User)

Alarm Message [NEIRTS [ Taghame [ condition

Test

oK Cancel

9th You can see user name of chat relevent to the token.

Tag Trigger Event - COM3_1_Present Value

Trigger List 71 W DO [coM3_1Present Value

Active
- R e >
I
RSl =7 9:46:06 5
L] 2T 9:46:06 <
Event Send to Telegram v
Token 439 BV3U Ll
[select Al Search Groups
To: (User) I
Alarm Message IEIRENY [I7agName [] condition
Test
OK Cancel
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10thCheck the desired receiver and select chat to use and choose alam message format
among time, tag name, and condition.
After enter test message in the bottom blank, click ‘Save and Test’ button.

Tag Trigger Event - COM3_1_Present Value

s B I .

Active

- rangee S

5
Chedk Time 27 9:46:06 s
L) 2H 9:46:06 $
Send to Telegram &

Telegram Setting
Token | 489 BV3U Liu
[CJselect al Search Groups
Tu:l (User) I
] Time: [“] Taghame [~] Condition
TEST I
Test
oK Cancel

11thYou can receive test message in Telegram
QY E ) Za il 62% @ 17:42

¢« A Autonics :

bot

/start jc15
Test 15458
Test 17.40

[Test][Time]2017-12-182%5:42:45[
TagName]COM3_1_PresentValue[Co
ndition](null) TEST

(L) 7/

12thTelegram message setting is completed.
When tag value maches the set condition, Telegram message is sent.
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2.4.9.4 Runtime Properties

You can desigante added runtime screen (Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph,
Color Map Graph, Gauge Graph, Histogram Graph, Device: Alarm History Grid) name, update

interval, and the others.

You can modify the name of the Grid in Run Ul general properties by clicking Grid at Runtime
Screen in Project dialog. You can also modify Update Interval time in Config. (Default: 1,000 ms.)

|Q

Version

1001

1001

1001

1.5.2.35

1.0.0.20

1.0.0.20

1.0.0.20

1.0.0.20

|— Alarm History Grid 1.0.0.1

Description

Grid Plugin Library
Multi Panel Plugin Library

Panel Plugin Library

Runtime Line Graph Plugin. ..
Runtime Bar Graph Plugin ...
Runtime Color Map Graph ...
Runtime Gauge Graph Plu. ..

Runtime Histogram Graph ...

Alarm History Grid Plugin L...

Property x

Run UI

- General
Mame
Information

= Configuration
Update Interval

Grid

1000 msec
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2.5 Runtime Screen Library
Double-click Ul item in Runtime Screen Library and the item is added in DAQ WorkSpace.
| |1Q
Name Version Description
=) Data
E Grid 1.0.0.1 Grid Plugin Library
Multi Panel 1.0.0.1 Multi Panel Plugin Library
E Panel 1.0.0.1 Panel Plugin Library
Line Graph 1.5.2.35  Runtime Line Graph Plugin. ..
Bar Graph 1.0.0,20  Runtime Bar Graph Plugin ...
E Color Map Graph 1.0.0.20  Runtime Color Map Graph ...
t Gauge Graph 1.0.0.20  Runtime Gauge Graph Plu...
B Histogram Graph 1.0.0.20  Runtime Histogram Graph ...
=) Alarm
Alarm History Grid 1.0.0.1 Alarm History Grid Plugin L...

oz
Modtus Master AT, 3,1

e o

e

Runtime Screen Library is a list of runtime screens for data monitoring.

Runtime screens support Data: Grid, Multi Panel, Panel, Line Graph, Bar Graph, Color Map
Graph and Gauage Graph, Histogram Graph, Device: Alarm History Grid. You can open multiple
screens at the same time for monitoring. Information such as screen position, screen size and
I/O source is saved when saving the project.
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2.5.1 Data
(1) Grid
[ Grid IEI@

No. Device Tag Hame Time Unit

COM3_1_Present Value 2016-04-20.. m

(2) Multi panel

@ Multi Panel

Time

2016-04-20 ...
2016-04-20 ...

(3) Panel

COM3_1_Present Value

2016-04-20 11:
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(4) Line Graph

™4 Line Graph (o @][=]

11:11:30 11:11:40 11:11:50 11:12:00 11:12:10 11:12:20 11:12:30
Time (hh:mm:ss)

Device Tag Name

| | coms.ks | com3_1 presentvalue |

(5) Bar Graph

M| Bar Graph =l =]

=

COM3_1_Set Value : 58 °C

PM3_1_Present Value : 25°C

Device Tag Name Time hh:mm:ss]

COM3_TK4 | COM3_1_Present Value

I COM3_TK4 | COM3_1_Set Value

< | T | »

(6) Color Map Graph

"4 Color Map Graph (o [@][=]

Device Tag Name
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(7) Gauge Graph

COM3_COM3_1_Present ...

4 UL

Gauge Graph [= | ==

Device Tag Hame Time hh:

4 (I 2

COM3_COM3_1_Present ...

4 (L

Gauge Graph = |[= =

Device Tag Hame Time hh:mm:ss:ms

L11=17=52451

(8) Histogram Graph

"\ Histogram Graph - COM3_1_Present Value

v Save Image

Device Tag Name

| coM3_TK4 | coM3_1 Present value 11:18:39:906

Time hh:mm:ss:msec
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2.5.2 Alarm
(1) Alarm History Grid

| =] Alarm Histery Grid [ [®][=]
No. Time Device Tag Name
2016-04-20 11:19:05:277 COM3_TK4

2016-04-20 11:19:14: 387 COM3_TK4

2016-04-20 11:19:15:401 COM3_TK4
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3 Getting Started

On a default layout screen, you generally work from left to right.

[ DagMester Free = 2 =)

Project View Tool Help

O 5 & B8 =

New Open Open
Fromlist  Praject

Save  Savehs | Conmect  Run Log fiew Log

Delete - Project

= General
Project Name Noname
Company
= Runtime Screen User
DAQ Space Description
= Data File
Data Folder
Data File Creation Rules
CSV Time Type
= Log Data Schedule
Log Data Schedule
Active Schedule OFF
= When Opening Project
Run Mode None
Layout Default

Change View +
Address Status

Delete Al Select Al Delete the selected item(s)

No. Device Address  Source Tag Name Type R/W ReadMode Unit Calculation Description
4 Standard Tag (0)
‘§  Advanced Tag (0)

The basic work order is as follows:

1st Select a device from the Support Device List in the very left side of the screen and
add it to My System.

2nd Select a device from My System and add a relevant unit (address).

3rd From the very left I/O List, add I/O items for monitoring to DAQ List at the bottom.

4th Select a monitoring screen from Runtime Screen library in the very right side of the
screen.

5th Drag an I/O source from DAQ List and drop it onto the Runtime Screen.

6th Configure RS-232 or Modbus TCP environment.

7th Connect (you can read and set the device parameters).

8th Run (data file logging is available).
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3.1 Support Device List - Selecting a Device
For example: TK4 (Address 4) is connected to RS-232 Port 1.

First, select the device to communicate with from the Supported Device List. The Support Device
List (docking screen) is a list of devices supported by DAQMaster. You can only communicate
with listed devices.(The Support Device List will be updated continuously).

Below is the example screen for the currently supported devices(as of Fabruary, 2017).

Type Series/Model name Function
il ARM Modbus Digital Remote 1/0
& BFC Digital Display, Fiber Optic Amplifier
m CT Programmable Counter (Timer)
. DS(A)-xT Intelligent Display Unit
. DS-RRT Intelligent Display Unit
. MP5 Pulse Meter (Modbus RTU)
& vesw Pulse Meter
. MP5Y Pulse Meter
a MT4 Multi Panel Meter
Autonics
i ! SCM-USuU2I 2-CH USB Temperature Data Logger
1 g SCM-WF48 SCM-WF48 Configuration
e
B TF3 Refrigeration Temperature Controller
A . .
N THD Temperature/Humidity Sensor
TK4 General-Purpose Temperature Controller
i ™2 2-CH Modular Type Temperature Controller
ﬁiﬁ T™M4 4-CH Modular Type Temperature Controller
. TX LCD Display Temperature Controller
[ =) TZ/TZN Dual PID Control Temperature Controller
B
1 Database Database
—
Miscellaneous |  \pg  ppE Client DDE Client
T
e, o OPC Client OPC Client
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Type Series/Model name Function
WMI Manager WMI Manager

“ DPU (1-Phase) Thyristor Unit

“ DPU (3-Phase) Thyristor Unit

. KN-2000W-D2 Multi Input Indicator
Process l KPN Digital Process Controllers
Automation

g_- KRN50 50mm Hybrid Recorder

B KRN100 100mm Hybrid Recorder

m KRN1000 LCD Touchscreen Paperless Recorder

Devices made in Script Editor

When a device is selected, you can see basic information about the device in Property window

as follows.

Property =

TK4

= 'File
Description
Date
Date Modified
Creation
Revision

= Wersion
Vendaor
Product
Major Revision
Minor Rewvision

If you click or double-click the device expand button (+) in the Support Device List, the spesific
list of support device will appear.
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Select the device you want to add to My System (Temperature Controller TK4). Double-click or

mouse right-click the selected device and click Add to My System to add the device.

<3
. = THD Temperature Humidity Controller c
‘ T @&, Refresh S
g
“ ™2 §= Add to My system Temperature Controller
1E Expand Al
E ™4 = Temperature Controller
= Collapse all
. T¥ Series TX Series
- TZfTZN Dual PID aute tuning controller
ﬂ Process Automation (7) =

= Refresh: Updates Support Device List when device files (*.dev) are added.

=  Add to my system: Adds device to My System to communicate.

=  Expand all: Shows the list of all supported devices.

=  Collapse all: Hides the list of all supported devices.

Double-click RS-232 or TCP/IP on the new DAQ interface, or select it and click OK.
(TK4 supports RS-232 communication and it displays only RS-232.)

You can modify the configuration of the added RS 232 or TCP/IP in properties.

T4 - DAQ Interfa

New DAQ Interface Added DAQ Interface
R5-232
TCR/IP
l CK l l Cancel l

If there is another devices added earlier, you can see added RS-232-COM1 on the Added DAQ

Interface.

TK4 - DAQ Interfa

MNew DAQ Interface Added DAQ Interface

R5-232
TCP/IP

[ [ e ]
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3.2

3.2.1

RS-232C

Setting RS-232, TCPIIP

Set up RS-232 for communication. Select RS-232 in My System and check Property window.

Property x

RS-232
- General
Mame R5-232
Information E]
-l Configuration
rrtist s [
Add Del P — View - Communication Port COM3=VCPD E]
Baudrate 2600 B
Hame Address Status Check Parity MNone E]
= RS-232 ComM3 Disconnect Stop Eit 2 E]
=} ModBus Master RTU, 3 Disconnec Bit Per Byte 3 B
= By ™ AUTONICS (1) EA Rardware None (=]
Software Mone E]
1 Disconnec DTR Control Disable B
RTS Flow Control Disable B

Property window displays information about the communication port currently in use.

If you want to change the name in My System, modify Name in Property window.

The Config items are following.

Iltem Description
Fix Init List Loads communication port list of computer at the point when
Search RS-232 is added, saves it to the Port List and then fixes it.
Port List | Auto Rearranges Port list, if the port list of computer (such as USB 232)
Search is changed.

Communication Port

Shows choice of connectable COM Ports.
You can designate the connected COM Port.

Baudrate 1,200, 2,400, 4,800, 9,600, 19,200, 38,400, 57,600, 115,200 bps

Check Parity Allows communication parity selection. (none, odd, even, mark,
space)

Stop Bit Selects Stop Bits. (1, 1.5, 2)

Bit Per Byte Selects Byte Size. (5, 6, 7, 8)

Hardware None, RTS/CTS

Software None, XON/XOFF

DTR Control Disable, enable, handshake

RTS Flow Control

Disable, enable, handshake, toggle
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3.2.2 TCPIIP
Set up TCP/IP for communication. Select TCP/IP in My System and check Property window.

Property x

TCP/IP
= General
My System x MName TCR/IP
Information
Add Del Change View - E]
Hame Address Status ol Configuration
= TCP/IP 127.0.0.1_,.. Disconnect Socket Type client E]
= ModBus Master RTU, 3 Disconnect Address 127.0.0.1
=] B KRMN100 Process Au... (1) EA Port 502
_ Connection Timeout 3000
: Disconnect Client Type Monblocking Mode E]
Auto Connection Mode Use E]

Property window displays information about the communication port currently in use.
If you want to change the name in My System, modify Name in Property window.

The Config items are following.

Item Description
Client Sets as client mode (when connecting KRN100)
Socket
Type
Server Sets as server mode.
Address Enters the designated IP Address from the main device.
Port Sets port number.
Connection Timeout Sets Connection Timeout
. After transmission, next transmission is available regardless
Non Blocking
Client Type of response. — -
Blockin After transmission, next transmission is availa